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Using the Digital Waveform Tool

Use the Digital Waveform tool to zoom or pan waveforms, mark and 
search for time or patterns, and read the difference between placed 
markers.

• Searching for a Single Data Value or Pattern (see the Markers help 
volume)

• “Searching for Timing Violations” on page 24

• “Checking Time Intervals Between Two Events” on page 22

• “Zooming - Setting the Time Base” on page 8

• “Offsetting Waveforms - Setting the Delay” on page 10

• “Loading and Saving Waveform Configurations” on page 26

• “Printing the Waveform Window” on page 29 

See Also Working with Markers (see the Markers help volume)

“Working with Labels to Set Waveform Attributes” on page 13

“Seeing Measurement Results - Popup on Run” on page 33

“Panning the Waveform” on page 20

“Displaying Waveforms by Time or Samples” on page 19

“Selecting Markers Trigger Reference” on page 27

“Snap a Marker to an Edge” on page 28

“Turning Tabs On or Off in the Display Window” on page 32

Using the Analysis Tab (see the Agilent Technologies 16700A/B-Series 

Logic Analysis System help volume)
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Using the Digital Waveform Tool
Using the Mixed Signal Tab (see the Agilent Technologies 16700A/B-

Series Logic Analysis System help volume) 

Main System Help (see the Agilent Technologies 16700A/B-Series Logic 

Analysis System help volume) 

Glossary of Terms (see page 41) 
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Chapter 1: Using the Digital Waveform Tool
Zooming - Setting the Time Base
Zooming - Setting the Time Base

Time/Samples Unit Field

To zoom in and view small areas of waveform data, use the time/
samples unit field. This field displays either Seconds/div or Samples/
div, depending on the display mode selected. The smaller the selected 
number, the smaller the waveform area displayed.

1. Select the value entry field.

2. Backspace or delete the current numbers.

3. Type in the new value. 

or,

• Select the icons. 

Quick Zoom Using the 
Touchscreen

To zoom, touch the upper-left corner and drag your finger to the lower-
right corner, then lift your finger. The zoomed display area will be the 
box you draw. To undo a zoom, touch any open space in the data area, 
then select Undo Scaling from the shortcut selection list that appears.

See Also “Displaying Waveforms by Time or Samples” on page 19

“Returning to Previous Zoom View - Undo” on page 8

Using the 16702B Knobs and Buttons

Using the 16702B Touchscreen 

Returning to Previous Zoom View - Undo

After several zoom operations on waveform data, you may want to 
return to a previous zoom view. To return to previous zoom views:
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Chapter 1: Using the Digital Waveform Tool
Zooming - Setting the Time Base
• Select anywhere in the viewing area, and select Undo scaling from the 
list. 

See Also

Using the 16702B Knobs and Buttons

Using the 16702B Touchscreen 
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Chapter 1: Using the Digital Waveform Tool
Offsetting Waveforms - Setting the Delay
Offsetting Waveforms - Setting the Delay

Delay Field

1. Select the delay value entry field.

2. Backspace or delete the current numbers.

3. Type in the new value. 

or,

• Select the icons. 

See Also “Panning the Waveform” on page 20 
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Chapter 1: Using the Digital Waveform Tool
Setting Waveform Height and Color
Setting Waveform Height and Color

To set height and color of all labels 

1. Select one label, a set of labels, or all labels (see page 31) to adjust height 
and color.

2. Select one or more attributes (see page 30) to change.

3. Select the color you wish to use. 
If the color you want is not shown, select Edit Colors (see page 35) to 
create the color you want. 

4. Use the arrows to select the desired waveform height. 

5. Select OK to accept your changes or Cancel to preserve the former 
settings. 

NOTE: You can also simply drag the bottom edge of the label box to make waveform 
height adjustments.

See Also Since each waveform is associated with a label, operations on labels will 
also affect how waveforms are displayed. For example, changing the 
polarity of a label in the Format window will invert the waveform on 
the display.

“Inserting, Replacing, or Deleting Labels” on page 14

“Overlaying or Expanding Waveforms” on page 16

“Rearranging the Label Order” on page 17

“Setting Waveform Default Attributes” on page 12 
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Chapter 1: Using the Digital Waveform Tool
Setting Waveform Default Attributes
Setting Waveform Default Attributes 

The buttons down the left-hand edge of the dialog select the associated 
attributes. To select a subset of the available attributes, select the 
buttons down the left-hand edge. 

• Black buttons indicate attributes that are selected. 

• Gray buttons indicate attributes that will be ignored. 

By selecting a subset of the attributes in the dialog, you can modify 
some of the defaults but leave the other defaults unchanged.

To Set the Waveform Default Attributes 

1. In the waveform menu bar, select Edit, and select Set default attributes.

2. From the Default Attribute dialog, select the desired label name width (see 
page 13). 

3. Select the color you wish to use. 
If the color you want is not shown, select Edit Colors (see page 35) to 
create the color you want. 

4. Use the arrows to select the default waveform height. 

5. Set ShowValue (see page 17) On or Off, and choose the numerical base. 

6. Select OK to accept your changes or Cancel to preserve the former default 
settings. 
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Chapter 1: Using the Digital Waveform Tool
Working with Labels to Set Waveform Attributes
Working with Labels to Set Waveform Attributes

NOTE: Labels are created in the Format window of the Instrument tool being used. If 
you need to create new labels or modify existing label names, or change the 
polarity of a label, go to the Instrument tool’s Format window.

The following label operations are performed in the waveform display:

• “Inserting, Replacing, or Deleting Labels” on page 14

• “Adjusting the Label Name Width” on page 13

• “Rearranging the Label Order” on page 17

• “Overlaying or Expanding Waveforms” on page 16

• “Display Data Values in Waveforms” on page 17

• “Setting the Label Font Size” on page 14

• “Setting Waveform Height and Color” on page 11 

• “Setting Waveform Default Attributes” on page 12 

Adjusting the Label Name Width

The label name can be set to the following types: 

• Short - only the name of the label name.

• Unique - the name of the Machine and label.

• Full - the name of the Frame, Slot, Machine, and label. 

1. Select one label, a set of labels, or all labels (see page 31) to adjust the 
label name width.

2. Select one or more attributes (see page 30) to change.

3. Select the Label format field and select the desired label name type.

4. Select OK. 
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Chapter 1: Using the Digital Waveform Tool
Working with Labels to Set Waveform Attributes
See Also “Setting Waveform Height and Color” on page 11 

“Setting Waveform Default Attributes” on page 12 

“Display Data Values in Waveforms” on page 17 

Setting the Label Font Size

Font settings are global. The font size you select is applied to all text in 
the display area.

1. From the waveform menu bar, select Options. Select Font.

2. From the selection list that appears, select the desired font size. 

Inserting, Replacing, or Deleting Labels

NOTE: Labels that appear in the Label List are defined in the Format window of the 
Instrument tool being used.

To insert or replace labels

1. Point to the desired label.

2. Select the desired Insert or Replace function.

3. From the Label Dialog, select a label from the Label List.

4. Select the desired label display mode (see page 15), and select Apply. 
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Working with Labels to Set Waveform Attributes
5. If you are done, select Close. 

To delete labels

1. Point to a label.

2. Select Delete in the selection list that appears. 

You can also access the label edit functions through Edit in the tool’s 
menu bar.

Label Display Mode

When labels are inserted, you can pick how they are displayed.

Sequential When labels are displayed in Sequential form, all bits in a label are 
displayed on separate lines, and, in descending order.

Individual When labels are displayed in Individual form, each bit in a label is 
selected separately and inserted on a separate line.

Individual Bit Selection

Overlay When labels Overlay, all bits in a label appear on the same line with the 
word all appearing to the right of the label name.
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Chapter 1: Using the Digital Waveform Tool
Working with Labels to Set Waveform Attributes
Overlaying or Expanding Waveforms

The bits of a label can be displayed as separate waveforms or as 
combined waveforms on one line.

To Expand Bits

When expanded, all bits assigned to a label are displayed separately on 
individual lines.

Display of Expanded Bits

1. Point to the label you want to expand. 

2. Select Expand from the selection list that appears. 

 

To Overlay Bits

When overlayed, all bits assigned to a label are displayed together on a 
single line.

Display of Overlaid Bits

1. Point to any bit of the label you want to overlay. 

2. Select Overlay from the selection list. 

See Also “Inserting, Replacing, or Deleting Labels” on page 14

“Label Display Mode” on page 15

“Setting Waveform Height and Color” on page 11

“Setting Waveform Default Attributes” on page 12 
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Chapter 1: Using the Digital Waveform Tool
Working with Labels to Set Waveform Attributes
Display Data Values in Waveforms

When a label is displayed in Overlay mode, by default the data values 
of the waveform are shown within the waveform. 

Data Values Displayed in Overlay Mode

To turn data values on or off

1. Select one label, a set of labels, or all labels (see page 31) to turn values on 
or off.

2. Select Change attributes... (see page 30). 

3. Select ShowValue On or Off

4. Select the desired numerical base. 

5. Select OK. 

Show Values Toggle Field

NOTE: The values are affected by the polarity which was set in the Format window. 
For example, the hexadecimal value "0000" will change to "FFFF" if the 
polarity of a label is changed from + to -.

Rearranging the Label Order

1. Point to a label.

2. Drag the highlighted label to its new location then release. 
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Working with Labels to Set Waveform Attributes
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Chapter 1: Using the Digital Waveform Tool
Displaying Waveforms by Time or Samples
Displaying Waveforms by Time or Samples

You can view waveform data in units of time/div or units of samples/div. 
Time units are referenced from the system clock, while samples are 
referenced from the sample clock.

1. Directly above the waveform display area, select the Seconds/div or 
Samples/div field.

2. Select the desired display mode. 
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Chapter 1: Using the Digital Waveform Tool
Panning the Waveform
Panning the Waveform

To pan or scroll through the displayed waveform, drag the waveform 
panning bar side to side.

As you pan (scroll the waveform data) using the panning bar, the Delay 
field will also change, showing the current delay from trigger.

See Also

“Offsetting Waveforms - Setting the Delay” on page 10 
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Chapter 1: Using the Digital Waveform Tool
Searching or Finding a Pattern or Event in Data
Searching or Finding a Pattern or Event in Data

To search for and find patterns or events in the waveform data, use 
markers.

1. Activate one marker. (see the Markers help volume)

2. Assign the marker (see the Markers help volume) as a Pattern marker.

3. Define a pattern (see the Markers help volume) that matches the event 
you wish to find.

4. To specify a particular occurrence of the pattern or event, change the 
marker’s occurs field and from reference field accordingly. 
For example, you could select the 10th occurrence of the pattern from the 
beginning of the data. 

You can also read the time interval between this event and other 
markers or the trigger by using a Marker Interval (see the Markers 
help volume) readout.
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Chapter 1: Using the Digital Waveform Tool
Checking Time Intervals Between Two Events
Checking Time Intervals Between Two Events

To check the time interval between to events, you need to use two 
markers. There are two ways to set up this measurement: 

• “Point to the Events and Manually Place the Markers” on page 22

• “Define the Events and Automatically Place the Markers” on page 22 

Point to the Events and Manually Place the 
Markers 

1. Activate two markers. (see the Markers help volume) You can skip this 
step if you are going to use G1 and G2 because they are always active. 

2. Assign both markers (see the Markers help volume) as Time markers.

3. In the display, point to the first desired event.

4. In the shortcut menu that appears, select Place marker, then select one of 
the markers. The marker you chose will appear marking the first event.

5. Point to the second event and place another marker on it.

6. Read the interval (see the Markers help volume) between the two 
referenced markers. 

Define the Events and Automatically Place the 
Markers

1. Activate two markers. (see the Markers help volume) You can skip this 
step if you are going to use G1 and G2 because they are always active. 

2. Assign both markers (see the Markers help volume) as Pattern markers.

3. In the Marker Setup dialog beside the first marker, select Define and 
define the pattern for the first event of interest. Set up the Marker 

Pattern For dialog as shown in the Search Pattern - Listing example. 
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Checking Time Intervals Between Two Events
(see the Markers help volume) 

4. Define the other marker as the other event.

5. Set the marker’s occurs field and from field to mark the particular 
occurrence of the event you want to check.

6. Read the interval (see the Markers help volume) between the two 
referenced markers. 
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Chapter 1: Using the Digital Waveform Tool
Searching for Timing Violations
Searching for Timing Violations

To search your data for timing violations, you use markers to define 
the timing event and to check whether the duration of the event meets 
your expectations. Setup time, hold time and bus cycle duration are 
examples of timing events that you could check in this way. There are 
two ways to search for timing violations:

• “Define the Beginning and End of the Event and Check the Duration” on 
page 24

• “Define the Duration and Check Each Event Occurrence Against It” on 
page 24 

Define the Beginning and End of the Event and 
Check the Duration

This measurement requires two activated markers. By default, G1 and 
G2 are available. If you wish to use the x or o markers, you must 
activate them (see the Markers help volume). This procedure will use 
the default G1 and G2 markers.

1. Place marker G1 (see the Markers help volume) at the beginning of the 
event.

2. Search and place marker G2 at the end of the event.

3. Read the interval (see the Markers help volume) between G1 and G2. 

4. Optional – Select the Search tab and increment the Next and Prev buttons 
to view all occurrences of the duration. 

Define the Duration and Check Each Event 
Occurrence Against It

1. Activate two markers. (see the Markers help volume) You can skip this 
step if you are going to use G1 and G2 because they are always active. 
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Chapter 1: Using the Digital Waveform Tool
Searching for Timing Violations
2. Assign one marker (see the Markers help volume) as a Pattern marker 
and the other marker as a Time marker.

3. In the Marker Setup dialog, select Define for the pattern marker, and 
define the pattern (see the Markers help volume) as the beginning of the 
event you want to check.

4. Set the time marker value to the expected interval from the pattern 
marker. Reference the Time marker from the pattern marker. 
For example, if you were verifying a bus cycle that should be 80 
nanoseconds or less, set up the time marker to be 80 nanoseconds from 
the pattern marker. 

5. Check the waveform to see if the event fits within or exceeds the width of 
the two markers.

6. To find the next occurrence of the event, increment the occurs field in the 
Marker Setup dialog for the pattern marker. The time marker will track the 
pattern marker automatically. 
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Chapter 1: Using the Digital Waveform Tool
Loading and Saving Waveform Configurations
Loading and Saving Waveform Configurations

Waveform Tool settings can be saved to a configuration file along with 
the tools connected to it, and loaded from a previously saved 
configuration file.

• Loading Configuration Files (see the Agilent Technologies 16700A/B-

Series Logic Analysis System help volume)

• Saving Configuration Files (see the Agilent Technologies 16700A/B-

Series Logic Analysis System help volume) 

NOTE: The Load Configuration window can be accessed via File->Load 
Configuration. 
The Save Configuration window can be accessed via File->Save 
Configuration.
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Chapter 1: Using the Digital Waveform Tool
Selecting Markers Trigger Reference
Selecting Markers Trigger Reference

When you have multiple data sets from a configuration with more than 
one Instrument tool, you can select the trigger point from any data set 
as the reference for markers.

1. From the waveform menu bar, select Options. Select Reference trigger.

2. From the Reference trigger dialog, select the desired data set.

3. Select Apply. 

NOTE: If you only have one Instrument tool in the configuration, the Trigger 

reference dialog is not available. The trigger point of the single data set is 
assigned by default.

The following example shows a multiple Instrument configuration and 
the selection of a data set. The trigger point of the selected data set is 
used by the markers as the trigger reference.
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Chapter 1: Using the Digital Waveform Tool
Snap a Marker to an Edge
Snap a Marker to an Edge

The Place marker function snaps the marker to the closest edge of a 
waveform. This function is convenient when display resolution is too 
low to guarantee exact placement of the marker. 

1. In the waveform display area, point to the desired waveform edge.

2. From the selection list that appears, select Place marker, then select the 
marker you want to place on that edge. 

NOTE: By default, Place marker works as described above. To override the default 
and place a marker at the present position of the cursor, select the Markers 
tab, then select any activated marker field to open the Marker Setup dialog. 
From the Marker Setup dialog, select the Place on edge selection box. The 
Place on edge selection box is a switch that enables or disables the "Snap to 
nearest edge" feature.
28



Chapter 1: Using the Digital Waveform Tool
Printing the Waveform Window
Printing the Waveform Window

The print windows operation enables you to print just the Waveform 
tool window. Use this operation if you want a hardcopy or electronic 
record of configurations and data currently displayed in the viewing 
area of the Waveform window.

NOTE: Only the currently displayed viewing area of the Waveform window is printed. 
If any data or configuration fields appear offscreen, scroll the desired data or 
configuration fields into the window’s viewing area before printing.

1. Optional - configure the Print Options (see the Agilent Technologies 

16700A/B-Series Logic Analysis System help volume) if desired. 
Print Options include print destination, file format type, filename 
autoincrement, color/b&w; pixel mapping, and landscape/portrait 
orientation. 

2. In the Waveform tool menu bar, select File. Select Print This Window. 
The print output will be as configured in the Print Options (Step 1 above). 

See Also Print Option (see the Agilent Technologies 16700A/B-Series Logic 

Analysis System help volume)

Printer Setup (see the Agilent Technologies 16700A/B-Series Logic 

Analysis System help volume)

“Including Comments on Screen Prints” on page 34 
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Selecting Attributes to Change
Selecting Attributes to Change

The buttons down the left-hand edge of the dialog select the associated 
attributes. To select a subset of the available attributes, select the 
buttons down the left-hand edge. 

• Black buttons indicate attributes that are selected. 

• Gray buttons indicate attributes that will be ignored. 

By selecting a subset of the attributes in the dialog, you can modify the 
defaults for the affected labels, but leave the other attributes for those 
labels unchanged.

See Also “Selecting Labels to Change” on page 31 
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Selecting Labels to Change
Selecting Labels to Change

To select one label to change:

• Select the label and select Change attributes. 
The Attribute dialog will open. 

To select all labels to change:

1. In the waveform menu bar, select Edit and select Select all. 

2. Select Edit again and select Change attributes. 
The Attribute dialog will open. 

See Also “Selecting Attributes to Change” on page 30 
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Turning Tabs On or Off in the Display Window
Turning Tabs On or Off in the Display Window

The tabs in the display window give you quick access and visual 
reference to all the capabilities in the display window. You may wish to 
turn the tabs off to simplify display content. 

• In the menu bar of the display tool, select Options, then select Tabs and 
set to On or Off. 
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Seeing Measurement Results - Popup on Run
Seeing Measurement Results - Popup on Run

By default, measurement results do not pop up automatically when an 
analyzer completes its run. If you wish to have a display of 
measurement results pop up when a run is completed, do the following:

• In the menu bar of the display tool, select Options, then select Popup on 

Run and set to On. 
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Including Comments on Screen Prints
Including Comments on Screen Prints 

When you have tabs turned on, you can also enter your own comments 
on screen. This allows you to obtain a printed copy of your screen that 
includes your comments.

• Turn tabs on, (see page 32) and under the Tabs On option, select Stack 

comments.

• Enter the text you wish to see in the print of your display. 
Each print can include multiple comment lines. If you need more than the 
default two comment lines, resize the comment text window using the 
sash. 
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Chapter 1: Using the Digital Waveform Tool
Editing Colors
Editing Colors 

To edit a color 

1. Select a color to change.

2. Move the Color Edit sliders to obtain the desired colors. 
The colors change in the display to show the result of your modifications.

3. Select Save to accept and use the new colors, and save them as the 
powerup default colors. 
Optional - Select Default to restore the original colors and save them as 
the powerup default colors. 

4. Select Close. 
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Run/Group Run Function
Run/Group Run Function

Using Run - Run All - Group Run 

The Run/Stop functions are initiated by selecting icons in the icon bar 
at the top of the tool windows. All instrument, display, and analysis tool 
windows will have one of the Run icons shown below to initiate the run 
function. 

When two or more instrument tools are configured, they can be run 
either independently or as a group. If run in a group, it is called an 
Intermodule measurement. Use the Intermodule Window (see the 
Agilent Technologies 16700A/B-Series Logic Analysis System help 
volume) to coordinate the arming in a "Group Run". A common "Group 
Run" configuration is to configure one instrument to trigger and then 
arm another instrument to start evaluation of its own trigger condition.

 The Run Single icon appears if you have a single instrument 
configured in your measurement and you want to run a single 
acquisition.

 The Run All icon always appears in the System, Workspace and 
Run Status windows. Also appears in instrument and display windows 
when you are using multiple instruments in your measurement and 
these instruments ARE NOT configured in an intermodule 
measurement (Group Run). This choice runs a single acquisition on all 
instruments in the configuration.

 The Group Run icon appears in all windows when you are using 
multiple instruments, and these instruments are configured into a 
Group Run. This choice runs a single acquisition on all instruments in 
the Group Run configuration.

 The Run Repetitive icon appears in all windows. It is used to run a 
Run Single, Run All, and a Group Run acquisition repetitively. The 
current run mode will continue to run until Cancel is selected.
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Run/Group Run Function
Using Stop

 The Stop icon terminates all of the run functions shown above.

• Stops a single instrument running a measurement (perhaps waiting for a 
trigger condition).

• Stops all instruments running separate measurements (easily viewed from 
the Workspace window).

• Stops all instruments running in a Group Run configuration. 

See Also

“Demand Driven Data” on page 38

“Checking Run Status” on page 37 

Checking Run Status

The Run Status dialog provides status information about the currently 
configured instruments, and the status of the run with respect to the 
trigger specification.

To access the Run Status dialog, select the Run Status icon in the 
System Window, or, select Window -> System -> Run Status
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Run/Group Run Function
Demand Driven Data

When an analyzer measurement occurs, acquisition memory is filled 
with data that is then transferred to the display memory of the analysis 
or display tools you are using, as needed by those tools. In normal use, 
this demand driven data approach saves time by not transferring 
unnecessary data.

Since acquisition memory is cleared at the beginning of a 
measurement, stopping a run may create a discrepancy between 
acquisition memory and the memory buffer of connected tools. Without 
a complete trace of acquisition memory, the display memory will 
appear to have ’holes’ in it which appear as filtered data.

This situation will occur in these cases: 

• If you stop a repetitive measurement after analyzer data has been cleared 
and before the measurement is complete.

• If a trigger is not found by the analyzer and the run must be stopped to 
regain control. 

To make sure all of the data in a repetitive run is available for viewing: 

• In the workspace, attach a Filter tool to the output of the analyzer.

• In the Filter, select "Pass Matching Data"

• In the filter terms, assure the default pattern of all "Don't Cares" (Xs). 

This configuration will always transfer all data from acquisition 
memory. While this configuration will increase the time of each run, it 
will guarantee that repetitive run data is available regardless of when it 
is stopped.
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Help - How to Navigate Quickly

1. Place mouse cursor anywhere in a help window.

2. Press the right mouse button.

3. Select desired destination. 

You can also access all navigation and search commands from the help 
window menu bar.
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Glossary
absolute  Denotes the time period 
or count of states between a captured 
state and the trigger state. An 
absolute count of -10 indicates the 
state was captured ten states before 
the trigger state was captured.

acquisition  Denotes one complete 
cycle of data gathering by a 
measurement module. For example, 
if you are using an analyzer with 
128K memory depth, one complete 
acquisition will capture and store 
128K states in acquisition memory.

analysis probe  A probe connected 
to a microprocessor or standard bus 
in the device under test. An analysis 
probe provides an interface between 
the signals of the microprocessor or 
standard bus and the inputs of the 
logic analyzer. Also called a 
preprocessor.

analyzer 1  In a logic analyzer with 
two machines, refers to the machine 
that is on by default. The default 
name is Analyzer<N>, where N is 
the slot letter.

analyzer 2  In a logic analyzer with 
two machines, refers to the machine 
that is off by default. The default 
name is Analyzer<N2>, where N is 
the slot letter.

arming  An instrument tool must be 
 

armed before it can search for its 
trigger condition. Typically, 
instruments are armed immediately 
when Run or Group Run is selected. 
You can set up one instrument to arm 
another using the Intermodule 

Window. In these setups, the second 
instrument cannot search for its 
trigger condition until it receives the 
arming signal from the first 
instrument. In some analyzer 
instruments, you can set up one 
analyzer machine to arm the other 
analyzer machine in the Trigger 

Window. 

asterisk (*)  See edge terms, 
glitch, and labels.

bits  Bits represent the physical logic 
analyzer channels. A bit is a channel 
that has or can be assigned to a label. 
A bit is also a position in a label.

card  This refers to a single 
instrument intended for use in the 
Agilent Technologies 16600A-series 
or 16700A/B-series mainframes. One 
card fills one slot in the mainframe. A 
module may comprise a single card or 
multiple cards cabled together.

channel  The entire signal path from 
the probe tip, through the cable and 
module, up to the label grouping. 

click  When using a mouse as the 
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Glossary
pointing device, to click an item, 
position the cursor over the item. 
Then quickly press and release the 
left mouse button.

clock channel  A logic analyzer 
channel that can be used to carry the 
clock signal. When it is not needed 
for clock signals, it can be used as a 
data channel, except in the Agilent 
Technologies 16517A.

context record  A context record is 
a small segment of analyzer memory 
that stores an event of interest along 
with the states that immediately 
preceded it and the states that 
immediately followed it.

context store  If your analyzer can 
perform context store 
measurements, you will see a button 
labeled Context Store under the 
Trigger tab. Typical context store 
measurements are used to capture 
writes to a variable or calls to a 
subroutine, along with the activity 
preceding and following the events. A 
context store measurement divides 
analyzer memory into a series of 
context records. If you have a 64K 
analyzer memory and select a 16-
state context, the analyzer memory is 
divided into 4K 16-state context 
records. If you have a 64K analyzer 
memory and select a 64-state 
context, the analyzer memory will be 
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divided into 1K 64-state records.

count  The count function records 
periods of time or numbers of state 
transactions between states stored in 
memory. You can set up the analyzer 
count function to count occurrences 
of a selected event during the trace, 
such as counting how many times a 
variable is read between each of the 
writes to the variable. The analyzer 
can also be set up to count elapsed 
time, such as counting the time spent 
executing within a particular function 
during a run of your target program.

cross triggering  Using intermodule 
capabilities to have measurement 
modules trigger each other. For 
example, you can have an external 
instrument arm a logic analyzer, 
which subsequently triggers an 
oscilloscope when it finds the trigger 
state.

data channel  A channel that 
carries data. Data channels cannot be 
used to clock logic analyzers.

data field  A data field in the pattern 
generator is the data value associated 
with a single label within a particular 
data vector.

data set  A data set is made up of all 
labels and data stored in memory of 
any single analyzer machine or 
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instrument tool. Multiple data sets 
can be displayed together when 
sourced into a single display tool. The 
Filter tool is used to pass on partial 
data sets to analysis or display tools.

debug mode  See monitor.

delay  The delay function sets the 
horizontal position of the waveform 
on the screen for the oscilloscope and 
timing analyzer. Delay time is 
measured from the trigger point in 
seconds or states.

demo mode  An emulation control 
session which is not connected to a 
real target system. All windows can 
be viewed, but the data displayed is 
simulated. To start demo mode, 
select Start User Session from the 
Emulation Control Interface and 
enter the demo name in the 
Processor Probe LAN Name field. 
Select the Help button in the Start 

User Session window for details.

deskewing  To cancel or nullify the 
effects of differences between two 
different internal delay paths for a 
signal. Deskewing is normally done 
by routing a single test signal to the 
inputs of two different modules, then 
adjusting the Intermodule Skew so 
that both modules recognize the 
signal at the same time.
 

device under test  The system 
under test, which contains the 
circuitry you are probing. Also known 
as a target system.

don’t care  For terms, a "don’t care" 
means that the state of the signal 
(high or low) is not relevant to the 
measurement. The analyzer ignores 
the state of this signal when 
determining whether a match occurs 
on an input label. "Don’t care" signals 
are still sampled and their values can 
be displayed with the rest of the data. 
Don’t cares are represented by the X 
character in numeric values and the 
dot (.) in timing edge specifications.

dot (.)  See edge terms, glitch, 
labels, and don’t care.

double-click  When using a mouse 
as the pointing device, to double-click 
an item, position the cursor over the 
item, and then quickly press and 
release the left mouse button twice.

drag and drop  Using a Mouse:
Position the cursor over the item, and 
then press and hold the left mouse 

button. While holding the left mouse 
button down, move the mouse to 
drag the item to a new location. When 
the item is positioned where you 
want it, release the mouse button.
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Using the Touchscreen:
Position your finger over the item, 
then press and hold finger to the 
screen. While holding the finger 
down, slide the finger along the 
screen dragging the item to a new 
location. When the item is positioned 
where you want it, release your 
finger.

edge mode  In an oscilloscope, this 
is the trigger mode that causes a 
trigger based on a single channel 
edge, either rising or falling.

edge terms  Logic analyzer trigger 
resources that allow detection of 
transitions on a signal. An edge term 
can be set to detect a rising edge, 
falling edge, or either edge. Some 
logic analyzers can also detect no 
edge or a glitch on an input signal. 
Edges are specified by selecting 
arrows. The dot (.) ignores the bit. 
The asterisk (*) specifies a glitch on 
the bit. 

emulation module  A module 
within the logic analysis system 
mainframe that provides an 
emulation connection to the debug 
port of a microprocessor. An E5901A 
emulation module is used with a 
target interface module (TIM) or an 
analysis probe. An E5901B emulation 
module is used with an E5900A 
emulation probe.
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emulation probe  The stand-alone 
equivalent of an emulation module. 
Most of the tasks which can be 
performed using an emulation 
module can also be performed using 
an emulation probe connected to 
your logic analysis system via a LAN.

emulator  An emulation module or 
an emulation probe.

Ethernet address  See link-level 

address.

events  Events are the things you 
are looking for in your target system. 
In the logic analyzer interface, they 
take a single line. Examples of events 
are Label1 = XX and Timer 1 > 400 

ns.

filter expression  The filter 
expression is the logical OR 
combination of all of the filter terms. 
States in your data that match the 
filter expression can be filtered out or 
passed through the Pattern Filter. 

filter term  A variable that you 
define in order to specify which 
states to filter out or pass through. 
Filter terms are logically OR’ed 
together to create the filter 
expression. 

Format  The selections under the 
logic analyzer Format tab tell the 
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logic analyzer what data you want to 
collect, such as which channels 
represent buses (labels) and what 
logic threshold your signals use.

frame  The Agilent Technologies 
16600A-series or 16700A/B-series 
logic analysis system mainframe. See 
also logic analysis system.

gateway address  An IP address 
entered in integer dot notation. The 
default gateway address is 0.0.0.0, 
which allows all connections on the 
local network or subnet. If 
connections are to be made across 
networks or subnets, this address 
must be set to the address of the 
gateway machine.

glitch  A glitch occurs when two or 
more transitions cross the logic 
threshold between consecutive 
timing analyzer samples. You can 
specify glitch detection by choosing 
the asterisk (*) for edge terms under 
the timing analyzer Trigger tab.

grouped event  A grouped event is 
a list of events that you have 
grouped, and optionally named. It can 
be reused in other trigger sequence 
levels. Only available in Agilent 
Technologies 16715A, 16716A, and 
16717A logic analyzers.

held value  A value that is held until 
 

the next sample. A held value can 
exist in multiple data sets.

immediate mode  In an 
oscilloscope, the trigger mode that 
does not require a specific trigger 
condition such as an edge or a 
pattern. Use immediate mode when 
the oscilloscope is armed by another 
instrument.

interconnect cable  Short name for 
module/probe interconnect cable.

intermodule bus  The intermodule 
bus (IMB) is a bus in the frame that 
allows the measurement modules to 
communicate with each other. Using 
the IMB, you can set up one 
instrument to arm another. Data 
acquired by instruments using the 
IMB is time-correlated.

intermodule  Intermodule is a term 
used when multiple instrument tools 
are connected together for the 
purpose of one instrument arming 
another. In such a configuration, an 
arming tree is developed and the 
group run function is designated to 
start all instrument tools. Multiple 
instrument configurations are done in 
the Intermodule window.

internet address  Also called 
Internet Protocol address or IP 
address. A 32-bit network address. It 
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is usually represented as decimal 
numbers separated by periods; for 
example, 192.35.12.6. Ask your LAN 
administrator if you need an internet 
address.

labels  Labels are used to group and 
identify logic analyzer channels. A 
label consists of a name and an 
associated bit or group of bits. Labels 
are created in the Format tab. 

line numbers  A line number (Line 
#s) is a special use of symbols. Line 
numbers represent lines in your 
source file, typically lines that have 
no unique symbols defined to 
represent them. 

link-level address  Also referred to 
as the Ethernet address, this is the 
unique address of the LAN interface. 
This value is set at the factory and 
cannot be changed. The link-level 
address of a particular piece of 
equipment is often printed on a label 
above the LAN connector. An 
example of a link-level address in 
hexadecimal: 0800090012AB.

local session  A local session is 
when you run the logic analysis 
system using the local display 
connected to the product hardware. 

logic analysis system  The Agilent 
Technologies 16600A-series or 
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16700A/B-series mainframes, and all 
tools designed to work with it. 
Usually used to mean the specific 
system and tools you are working 
with right now.

machine  Some logic analyzers allow 
you to set up two measurements at 
the same time. Each measurement is 
handled by a different machine. This 
is represented in the Workspace 
window by two icons, differentiated 
by a 1 and a 2 in the upper right-hand 
corner of the icon. Logic analyzer 
resources such as pods and trigger 
terms cannot be shared by the 
machines.

markers  Markers are the green and 
yellow lines in the display that are 
labeled x, o, G1, and G2. Use them to 
measure time intervals or sample 
intervals. Markers are assigned to 
patterns in order to find patterns or 
track sequences of states in the data. 
The x and o markers are local to the 
immediate display, while G1 and G2 
are global between time correlated 
displays.

master card  In a module, the 
master card controls the data 
acquisition or output. The logic 
analysis system references the 
module by the slot in which the 
master card is plugged. For example, 
a 5-card Agilent Technologies 16555D 
  



Glossary
would be referred to as Slot C: 

machine because the master card is 
in slot C of the mainframe. The other 
cards of the module are called 
expansion cards.

menu bar  The menu bar is located 
at the top of all windows. Use it to 
select File operations, tool or system 
Options, and tool or system level 
Help.

message bar  The message bar 
displays mouse button functions for 
the window area or field directly 
beneath the mouse cursor. Use the 
mouse and message bar together to 
prompt yourself to functions and 
shortcuts.

module/probe interconnect cable  

The module/probe interconnect cable 
connects an E5901B emulation 
module to an E5900B emulation 
probe. It provides power and a serial 
connection. A LAN connection is also 
required to use the emulation probe.

module  An instrument that uses a 
single timebase in its operation. 
Modules can have from one to five 
cards functioning as a single 
instrument. When a module has more 
than one card, system window will 
show the instrument icon in the slot 
of the master card.
 

monitor  When using the Emulation 
Control Interface, running the 
monitor means the processor is in 
debug mode (that is, executing the 
debug exception) instead of 
executing the user program.

panning  The action of moving the 
waveform along the timebase by 
varying the delay value in the Delay 
field. This action allows you to 
control the portion of acquisition 
memory that will be displayed on the 
screen. 

pattern mode  In an oscilloscope, 
the trigger mode that allows you to 
set the oscilloscope to trigger on a 
specified combination of input signal 
levels.

pattern terms  Logic analyzer 
resources that represent single states 
to be found on labeled sets of bits; for 
example, an address on the address 
bus or a status on the status lines. 

period (.)  See edge terms, glitch, 
labels, and don’t care.

pod pair  A group of two pods 
containing 16 channels each, used to 
physically connect data and clock 
signals from the unit under test to the 
analyzer. Pods are assigned by pairs 
in the analyzer interface. The number 
of pod pairs avalaible is determined 
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by the channel width of the 
instrument.

pod  See pod pair

point  To point to an item, move the 
mouse cursor over the item, or 
position your finger over the item.

preprocessor  See analysis probe.

primary branch  The primary 
branch is indicated in the Trigger 

sequence step dialog box as either 
the Then find or Trigger on 
selection. The destination of the 
primary branch is always the next 
state in the sequence, except for the 
Agilent Technologies 16517A. The 
primary branch has an optional 
occurrence count field that can be 
used to count a number of 
occurrences of the branch condition. 
See also secondary branch.

probe  A device to connect the 
various instruments of the logic 
analysis system to the target system. 
There are many types of probes and 
the one you should use depends on 
the instrument and your data 
requirements. As a verb, "to probe" 
means to attach a probe to the target 
system.

processor probe  See emulation 

probe.
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range terms  Logic analyzer 
resources that represent ranges of 
values to be found on labeled sets of 
bits. For example, range terms could 
identify a range of addresses to be 
found on the address bus or a range 
of data values to be found on the data 
bus. In the trigger sequence, range 
terms are considered to be true when 
any value within the range occurs.

relative  Denotes time period or 
count of states between the current 
state and the previous state. 

remote display  A remote display is 
a display other than the one 
connected to the product hardware. 
Remote displays must be identified to 
the network through an address 
location.

remote session  A remote session is 
when you run the logic analyzer using 
a display that is located away from 
the product hardware. 

right-click  When using a mouse for 
a pointing device, to right-click an 
item, position the cursor over the 
item, and then quickly press and 
release the right mouse button.

sample  A data sample is a portion of 
a data set, sometimes just one point. 
When an instrument samples the 
target system, it is taking a single 
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measurement as part of its data 
acquisition cycle.

Sampling  Use the selections under 
the logic analyzer Sampling tab to tell 
the logic analyzer how you want to 
make measurements, such as State 
vs. Timing.

secondary branch  The secondary 
branch is indicated in the Trigger 

sequence step dialog box as the Else 

on selection. The destination of the 
secondary branch can be specified as 
any other active sequence state. See 
also primary branch.

session  A session begins when you 
start a local session or remote 

session from the session manager, 
and ends when you select Exit from 
the main window. Exiting a session 
returns all tools to their initial 
configurations.

skew  Skew is the difference in 
channel delays between 
measurement channels. Typically, 
skew between modules is caused by 
differences in designs of 
measurement channels, and 
differences in characteristics of the 
electronic components within those 
channels. You should adjust 
measurement modules to eliminate 
as much skew as possible so that it 
does not affect the accuracy of your 
 

measurements.

state measurement  In a state 
measurement, the logic analyzer is 
clocked by a signal from the system 
under test. Each time the clock signal 
becomes valid, the analyzer samples 
data from the system under test. 
Since the analyzer is clocked by the 
system, state measurements are 
synchronous with the test system. 

store qualification  Store 
qualification is only available in a 
state measurement, not timing 

measurements. Store qualification 
allows you to specify the type of 
information (all samples, no samples, 
or selected states) to be stored in 
memory. Use store qualification to 
prevent memory from being filled 
with unwanted activity such as no-
ops or wait-loops. To set up store 
qualification, use the While storing 
field in a logic analyzer trigger 
sequence dialog.

subnet mask  A subnet mask blocks 
out part of an IP address so that the 
networking software can determine 
whether the destination host is on a 
local or remote network. It is usually 
represented as decimal numbers 
separated by periods; for example, 
255.255.255.0. Ask your LAN 
administrator if you need a the 
subnet mask for your network.
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symbols  Symbols represent 
patterns and ranges of values found 
on labeled sets of bits. Two kinds of 
symbols are available: 

• Object file symbols - Symbols 
from your source code, and 
symbols generated by your 
compiler. Object file symbols may 
represent global variables, 
functions, labels, and source line 
numbers. 

• User-defined symbols - Symbols 
you create. 

Symbols can be used as pattern and 
range terms for: 

• Searches in the listing display.

• Triggering in logic analyzers and 
in the source correlation trigger 
setup.

• Qualifying data in the filter tool 
and system performance analysis 
tool set. 

system administrator  The system 
administrator is a person who 
manages your system, taking care of 
such tasks as adding peripheral 
devices, adding new users, and doing 
system backup. In general, the 
system administrator is the person 
you go to with questions about 
implementing your software.
50
target system  The system under 
test, which contains the 
microprocessor you are probing.

terms  Terms are variables that can 
be used in trigger sequences. A term 
can be a single value on a label or set 
of labels, any value within a range of 
values on a label or set of labels, or a 
glitch or edge transition on bits 
within a label or set of labels.

TIM  A TIM (Target Interface 
Module) makes connections between 
the cable from the emulation module 
or emulation probe and the cable to 
the debug port on the system under 
test. 

time-correlated  Time correlated 
measurements are measurements 
involving more than one instrument 
in which all instruments have a 
common time or trigger reference.

timer terms  Logic analyzer 
resources that are used to measure 
the time the trigger sequence 
remains within one sequence step, or 
a set of sequence steps. Timers can 
be used to detect when a condition 
lasts too long or not long enough. 
They can be used to measure pulse 
duration, or duration of a wait loop. A 
single timer term can be used to 
delay trigger until a period of time 
after detection of a significant event. 
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timing measurement  In a timing 
measurement, the logic analyzer 
samples data at regular intervals 
according to a clock signal internal to 
the timing analyzer. Since the 
analyzer is clocked by a signal that is 
not related to the system under test, 
timing measurements capture traces 
of electrical activity over time. These 
measurements are asynchronous 
with the test system. 

tool icon  Tool icons that appear in 
the workspace are representations of 
the hardware and software tools 
selected from the toolbox. If they are 
placed directly over a current 
measurement, the tools automatically 
connect to that measurement. If they 
are placed on an open area of the 
main window, you must connect them 
to a measurement using the mouse. 

toolbox  The Toolbox is located on 
the left side of the main window. It is 
used to display the available 
hardware and software tools. As you 
add new tools to your system, their 
icons will appear in the Toolbox.

tools  A tool is a stand-alone piece of 
functionality. A tool can be an 
instrument that acquires data, a 
display for viewing data, or a post-
processing analysis helper. Tools are 
represented as icons in the main 
window of the interface. 
 

trace  See acquisition.

trigger sequence  A trigger 
sequence is a sequence of events that 
you specify. The logic analyzer 
compares this sequence with the 
samples it is collecting to determine 
when to trigger.

trigger specification  A trigger 
specification is a set of conditions 
that must be true before the 
instrument triggers.

trigger  Trigger is an event that 
occurs immediately after the 
instrument recognizes a match 
between the incoming data and the 
trigger specification. Once trigger 
occurs, the instrument completes its 
acquisition, including any store 
qualification that may be specified.

workspace  The workspace is the 
large area under the message bar and 
to the right of the toolbox. The 
workspace is where you place the 
different instrument, display, and 
analysis tools. Once in the workspace, 
the tool icons graphically represent a 
complete picture of the 
measurements.

zooming  In the oscilloscope or 
timing analyzer, to expand and 
contract the waveform along the time 
base by varying the value in the s/Div 
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field. This action allows you to select 
specific portions of a particular 
waveform in acquisition memory that 
will be displayed on the screen. You 
can view any portion of the waveform 
record in acquisition memory. 
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cancel, 36
change scaling, 8
color, editing in waveforms, 35
comments on display printouts, 32, 

34

D

data values, display with 
waveforms, 17

delay, setting the, 10
demand driven data, 38
disable/enable run status window, 

37
display waveforms by time or 

sample, 19
display window pops up when run 

completes, 33

E

example measurements, 21, 22, 24
expanding waveform/labels, 16

F

finding pattern, 21
fonts, setting the size, 14

G

group run, 36

H

hardcopy, 29
help, 39
help, topic index, 27

I

independent run, 36
Individual, label display mode, 15
interval, checking, 22
 

L

label, setting the name width, 13
Labels, 13, 14, 15, 16, 17
Labels, in the waveform display, 13
loading Waveform Configurations, 

26

M

Markers, 21, 22, 24
measurement examples, 21, 22, 24
measurement, run options, 36

O

options, run, 36
Overlay, label display mode, 15
overlaying waveforms/labels, 16

P

panning the waveform, 20
pattern, finding, 21
place a marker, 28
polarity of waveform display, 17
printer, 29
printing windows, configurations, 

29

R

reference, trigger, 27
repetitive, 36
repetitive data display, 38
run, 36
run options, 37
run status, checking, 37
run status, disable window, 37

S

saving Waveform Configurations, 
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scaling, undo last zoom, 8
Search, 21, 24
Sequential, label display mode, 15
single, 36
status, 37
stop, 36

T

tabs, turning on or off in display 
window, 32

time between events, 22
time violation, searching for, 24
time, checking, 22
timebase, setting the, 8
trigger, select the reference, 27

U

undo, undo last zoom, 8

W

waveform display attributes, 
selecting for change, 30

waveform labels, selecting for 
change, 31

waveform, attributes, 11
waveform, default attributes, 12
waveform, offsetting from trigger, 

10
waveform, panning the, 20
waveform, setting height and color, 

11
waveform, snap markers to edge, 

28
waveforms, display data values in, 

17
window, printing, 29
workspace, 29

Z

zooming in on waveforms, 8
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